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Important Note

Due to the nature of CAN instrumentation, you cannot just physically connect a measurement
module to a bus and expect data from that module to be available. The NH3;CAN measurement
module has to be set up to send the data required and the receiving device (ex. data acquisition
software) has to know what is being sent. The setting up of modules and the production of a .dbc file
used by the receiving device to interpret the data sent, is performed using the supplied Configuration
Tool (software) which runs on a PC. 2-25-2015
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Complex measurement systems can be easily built with
LambdaCAN*, NOxCAN*, NH;CAN, and baroCAN modules.
Here is a five-channel lambda, O,, and NOXx pressure-compensated
in-vehicle system.



Introduction

The NH3CAN module kit is a compact, ceramic sensor-based NH3; measurement device. See
Appendix A for kit contents. The specification for the kit is as follows:

Ranges: NH3: 0 to 2000 ppm (wet), (A > 1 only)
Pressure: 0 to 517 kPa, 0 to 75 Psia

Accuracy: NHsz: =5 ppm (0 to 200 ppm)
Pressure: £ 5.2 kPa, £ 0.75 Psia

Response Times: NHj: Less than 1 sec.
Pressure: <5ms

NH3 Sensor Mounting: 18mm x 1.5mm thread. 22mm hex. Preferentially mount the sensor
in a location where its sensing end is unlikely to be immersed or
sprayed with liquid water, urea, oil, fuel, or antifreeze.

Maximum Exhaust Temperature: 450 °C, 842 °F

The NH3; sensor is designed to be used downstream of a SCR (Selective Catalytic Reduction)
catalyst or where there is not significant amounts of CO (carbon monoxide). This is due to
the sensor’s cross-sensitivity to CO (i.e. 40 ppm of CO appears as 1 ppm of NH3).

Setup and calibration of the NH3CAN kit is performed using the supplied PC software
program called “The Configuration Tool”. The Configuration Tool requires a CAN
communication device to communicate with one or more ECM CAN modules (i.e. NH3;CAN,
NOxCAN~*, LambdaCAN*, baroCAN, appsCAN) or analyzers (i.e. NOx 5210, Lambda
5220, EGR 5230, NH3 5250). While the tool is being used with modules, just ECM modules
set to stand-alone mode (see Appendix B) should be connected to the CAN bus. While the
tool is being used with analyzers, just analyzers should be connected to the CAN bus. With
analyzers, the Configuration Tool is just used to produce .dbc files. However with modules,
the Configuration Tool replaces the analyzer’s display head as the user interface so it must do
much more. This document focuses on using the Configuration Tool with ECM’s NH3;CAN
module.

The Configuration Tool supports four CAN communication devices: Kvaser, ETAS, Peak
USB-to-CAN adapters, and the VectorCAN CAN adapter card. Driver software for one of
these adapters must be installed prior to using the Configuration Tool. This software will be
supplied with the adapter or be available on-line. ECM’s Configuration Tool is delivered on
a CD.

Once the adapter’s driver and the Configuration Tool software are installed, and with the
module(s) powered and connected to the CAN adapter, start the Configuration Tool software.
Click on the “Modules” tab, select the CAN adapter, and click on the “START” button.

The software will identify the modules on the bus and display them in the “Module” field. If
this does not happen, make sure that the CAN bus is properly terminated (i.e. resistors).
Open the Module field to see all the modules on the bus. If a module is not listed, one reason
could be that its Node ID is the same as another module. To resolve this, remove all modules
except the “missing” one from the CAN bus, STOP then START the software, and change
that module’s Node ID. Another reason that a module is not listed could be that the module
is in EIB mode instead of stand-alone mode. All modules must be in stand-alone mode.




To configure one of the modules (ex. change its Node ID) or to look at that module’s data,
you have to select that module in the “Module” field.

There are three things you can do with modules using the Configuration Tool:

1. Configure a module. This includes calibrating a sensor attached to the module.
2. Look at data coming from that module in real-time and optionally log it.
3. Produce a .dbc file to be used by a device receiving module data.

Alternatively, 1. and 2. (above) can be performed by direct CAN communication with the
NH3;CAN module using user-written software. For information on how to do this and
detailed information about the modules, refer to the NH;CAN Programmer’s Manual.



Configuring a Module

Normally, you will be configuring a module to be used in stand-alone mode. Stand-alone
mode is used when the modules are connected to a CAN bus that goes directly to a data
acquisition or control system. In stand-alone mode, a module’s configuration is performed by
selecting one of the tasks in the “Task” field. When a module is connected to a NOx 5210,
Lambda 5220, EGR 5230, or NH3 5250 Analyzer, it must be in EIB mode. In EIB mode,
most of these tasks are performed using the analyzer. Appendix B describes how to
configure a module to operate in one mode or the other.

The following assumes that the module is to be used in stand-alone mode. The tasks
available for NH3;CAN modules are listed in Table 1.
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Change Node ID: Allowable range 0x01 to 0x7F (hex). When you assign a Node 1D (NID),
the following CAN IDs cannot be used by any other devices on the bus:
0x00, 0x80 + NID, 0x180 + NID, 0x280 + NID, 0x380 + NID, 0x480 + NID,
0x580 + NID, 0x600 + NID, 0x700 + NID, Ox7E4, OX7ES.

View Module Information: Manufacturer’s Name, Hardware Version, Software Version

Set Broadcast Rate: All activated TPDOs are transmitted every “n” milliseconds. “n” can
be programmed. 5 ms is the minimum. Default: 5 ms.

Set Averaging Filters: Before the data is transmitted by the module (at the broadcast rate), it
can be averaged. There are two averaging filters (alphas): one for NH3 and one for
Pressure. Alphas can range from 0.001 to 1 and are used in the recursive averaging
filter: AvgData; = alpha x Data; + (1-alpha) x AvgData.;.

Where: AvgDatay is the transmitted average data at time “t”.

Datay is the raw data at time “t”.

AvgData; is the previously transmitted average data.
This formula is executed every 5 ms regardless of broadcast rate. Note that if Alpha =
1, there is no averaging and the data taken at time “t” becomes the average value at
time “t” and hence the broadcast value. When changing the NHj filters, make them
both the same value. Default Alpha values: 0.375.

Enter Pressure Sensor Constants: N and C are the gain and offset of the pressure sensor.
N and C are written on a label attached to the pressure sensor. P (psia) = N x (V - C).
V = voltage from sensor.

Zero NHgs: User enters displayed NH3 value (TPDO data) and the actual NH3 value of the
“zero” gas. Zero gas does not necessarily have to be exactly zero. A non-zero value
can be entered.

Span NHj: User enters displayed NH3 value (TPDO data) and the actual NH3 value of the
gas. Preferentially Span near the upper NH3 value to be measured.

Delta NH3 Table: This table is used to modify the calculated NH3; (parameter NH3R) via a
user-entered look-up table generating a new NH3 parameter (parameter
NH3). NH3 = NH3R + Delta. Linear interpolation is performed between
delta points.

Hardware Reset: Equivalent to powering the module down then up again.

Reset TPDOs to Factory Settings: These are the parameters displayed and transmitted.
TPDO stands for Transmit Process Data Object.

Toggle Sensor Settings: Allows power to ceramic sensor to be turned on and off and enables
rapid sensor warm-up scheduling (Default: On (fast)).

Toggle TPDO CAN ID Auto Set: Enable and disable TPDO CAN ID Auto Set.

Default: Enabled.

Export & Import Module Configurations: This simplifies the task of programming several
modules the same way.

Table 1: Task List for NH;CAN Modules



Calibration of the NH; Sensor

Sensors shipped with NH3CAN modules have been calibrated (i.e. zeroed and spanned)
before leaving the factory. It is recommended that they be calibrated periodically during use.
How often can only be determined by your experience. Alternatively, sensors can be sent to
ECM for recalibration.

Calibration information (both factory calibration and user calibration) for the NH3 sensors is
stored in a memory chip in the sensor’s connector. Therefore, the sensor does not have to be
used with the module it was calibrated with. Once calibrated, the sensor can be sent to
another site to be used. After use, the sensor can be returned to the calibration center for
recalibration thus compensating for any sensor aging. Centralization of calibration in this
way improves measurement consistency and extends useful sensor life.

Zero and Spanning the NH; Sensor

A Zero should be performed before a SPAN. A user-performed Zero and Span can be
cleared, reverting the sensor to using the factory Zero and Span.

The NH; sensor can be zero’d in ambient air or in the exhaust of an engine. To perform a
Zero:

1. The NHg3 sensor and pressure sensor (if so equipped) should on for at least 20
minutes.

2. Hang the NHj3 sensor and the pressure sensor (if equipped) in ambient, stationary air.
Or put the NH3 sensor in the exhaust of zero NHs.

3. Select NH3 as a TPDO parameter.

4. Select the Task “Zero NH3”. Enter the displayed NH3 (the TPDO parameter) and the
actual NH3 (which should be zero), then click on “Zero”.

There are two ways to perform a Span of the NH3 sensor: using model gases or in the exhaust
of an engine. To perform a Span:

1. The NHg3 sensor and pressure sensor (if so equipped) should on for at least 20
minutes.

2. Put the NHj; sensor and the pressure sensor (if so equipped) in the model gas
calibration apparatus shown in Figure 1 or in the exhaust of an engine.

3. For the case of the model gas calibration apparatus, adjust the flowrates to get
approximately 15% O, 1.5% HO, your target calibration NH3 ppm (typically 100),
balance N,. For the NH3 tank concentration shown and a target of 100 ppm NHs, the
flowrate through flowmeter #2 will be about 1/9™ that through the bubbler. This will
give the approximate 1.5% H,O required. To set the %0, and NH3 ppm level, use a
NOXCANt or NOx 5210T analyzer. With the Type T NOx sensor used in these
devices, NH3 will be read as NOx. The NH3 must not be bubbled nor should there be
any condensed water from the output of the bubbler to downstream of the NH3 sensor.
Otherwise, the condensed water will absorb the NH3; and the span process will be
problematic.




. For the case of using the exhaust of an engine to span the NH; sensor, you must know
the wet NH3 concentration from another instrument.

. Select NH3 as a TPDO parameter.

Select the Task “Span NH3”. Enter the displayed NH3 (the TPDO parameter) and the

actual NHg, then click on “Span”.
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Figure 1: Model Gas Calibration Apparatus



Selecting What Data is to be Sent (TPDOS)

Data sent from NH3CAN modules is packaged as TPDOs (Transmit Process Data Object).
Each TPDO contains two pieces of data and each module can send up to four TPDOs. All
selected TPDOs will be sent at the broadcast rate. For example, if the broadcast rate is 5 ms
and four TPDOs were selected to be sent, then eight pieces of data would be transmitted
every 5 ms. To avoid slowing down the effective data rate on the CAN bus, select the
number of TPDOs to be sent and the broadcast rate sparingly. For the case of multiple
modules sending multiple TPDOs on the same CAN bus, the minimum (i.e. fastest) broadcast
rate is given by:

Minimum Broadcast rate (ms) = The total number of TPDOs for all modules x 0.3125

For example, if there are eight modules, each sending two TPDOs, the minimum broadcast
rate is 5 ms.

The data transmitted is selected in the “Data” area of the Configuration Tool. Activate the
number of TPDOs to be used by clicking in its box to put in a check mark. Select the data
contained in each TPDO using the pull-down windows. The list of available parameters for
the NH3CAN module is given in Table 2.

Note that in the parameter list, there are two NH3s: NH3R (NH3 Real) and NH3 (NHs).
NH3R is the NH3 value calculated by the module.

NH3 is the NH3; value calculated by the module and modified by the Delta NH3 Table
according to the relationship:

NH3 = NH3R + Delta NH3 Table value (interpolated from table)




Name Parameter Description

NH3R NHj before the addition of Delta NH3 Table (ppm)
CELI1 Cell 1 voltage (mV)

CEL2 Cell 2 voltage (mV)

RPVS NH3; sensor internal Vs cell resistance (Ohms)

VHCM Desired heater voltage commanded by the module (V)
VS NHj sensor internal Vs cell voltage

VSW Supply voltage at the module (V)

VH Actual heater voltage at the module (V)

TEMP Temperature of the module circuit board (deg C)

CIR Cell 1 raw bits (bits)

C2R Cell 2 raw bits (bits)

ERFL Module error flags (unsigned long format)

ERCd ECM CANOpen Error Code (unsigned integer)

PR10 10 bit Pressure sensor output voltage (unsigned integer format)
P Pressure sensor measured pressure (absolute) in mmHg
MODE NH; measurement mode (hex)

RCL NHs cal constant (no units)

SCF NHs scale factor (no units)

NH3 NHj; after addition of Delta NH3 Table (ppm)

PVLT Raw volts from pressure sensor (V)

PKPA Pressure sensor measured pressure (absolute) in kPa
PBAR Pressure sensor measured pressure (absolute) in bar
PPSI Pressure sensor measured pressure (absolute) in psi

Table 2: NH3;CAN Parameter List




Producing a .dbc File

A .dbc file describes to the device receiving data from one or more CAN modules what is in
the data packages. For each module, the packages will contain data for the parameters
selected in the activated TPDOs and an error code. The Configuration Tool has a tool called
“Generate .dbc...” that will generate a .dbc file for all the CAN modules on a CAN bus.
Make sure that each module is configured as desired and that all modules are on the bus
before the “Generate .dbc...” button is pushed. Data package information from all the
modules is stored in the one .dbc file produced.

Programs importing the .dbc file and applying it to the CAN data transmitted by the modules
will see data, etc identified as follows:

Data: name_nid[units]
where: name = parameter name. See Table 2.
nid = node id of module in hex
units = units of parameter
for example: NH3_0X01[%] which is the NH3 parameter from module with nid 0X01
Error code: ECM_Error_Code _nid

where nid = node id of module in hex
error code is in hex and given in Table 3

for example: ECM_Error_Code_0x11
Auxiliary: ECM_Auxiliary _time[sec]
where: time = decrementing countdown to module activation in hex

for example: ECM_Auxiliary_0X12[sec]




Error

Code Module LED Action Description of Error
0000 Green ON All OK, (green LED constantly on)
0001 Flashing Green 10hz Sensor warm-up period
0002 Green/Both/Red 2s Power on reset / Init hardware
16 bit ADC failed to init. Internal module error. Contact
0011 Pulse Red 1x/2s ECM.
0012 Pulse Red 1x/2s +Vsw shorted. Internal module error. Contact ECM.
0013 Red ON NH; sensor turned off (red LED constantly on)
NHj sensor heater or cable open, or NH3 sensor not
0014 Pulse Red 1x/2s connected.
0015 Pulse Red 1x/2s NHj; sensor heater or cable shorted. Bad NH; cable or sensor.
Memory chip in NHj sensor’s shorted. Bad NHj cable or
0021 Pulse Red 2x/2s Sensor.
No memory chip in NH; sensor detected. Bad NHj cable or
0022 Pulse Red 2x/2s Sensor.
0023 Pulse Red 2x/2s CRCI16 error. Bad NHj; cable or sensor.
0024 Pulse Red 2x/2s Invalid NH; sensor memory chip parameter. Wrong sensor.
0025 Pulse Red 2x/2s Non-compatible NH; sensor memory chip format (old Rev.)
0031 Pulse Red 3x/2s Vsw < 6 for > 7 sec. Supply voltage too low.
0032 Pulse Red 3x/2s Vsw >32 V. Supply voltage too high.
0041 Pulse Red 4x/2s VS too high. Bad NHj cable or sensor.
RPVS too high. Sensor too cold, bad, or battery voltage too
0051 Pulse Red 5x/2s low.
0052 Pulse Red 5x/2s (VH Commanded — VH Measured) > 0.5 V for > 10 sec.
Battery voltage too low.
0065 Pulse Red 6x/2s User data (span) in NH; sensor memory chip corrupted.

User must reperform NH; sensor span.

10

Table 3: NH3CAN Error Codes List




Using the dashCAN™* Display

dashCAN~* (i.e. all dashCANSs) is a small (105 mm x 63 mm x 63 mm for dashCAN and
dashCAN2, or 105 mm x 63 mm x 165 mm for dashCAN+) display for CAN networks
containing ECM CAN modules. dashCAN has two displays and no analog outputs.
dashCAN2 has two displays and two programmable analog outputs. dashCAN+ has two
displays and six programmable analog outputs. dashCAN* comes with a two meter cable
and a “T” (P/N 09-05). Simply attach dashCAN* to the CAN bus and parameters from one
or two ECM CAN modules can be displayed and converted to analog outputs (dashCAN2 or
dashCAN+ only). The top display and half the analog outputs can be assigned to one module
and the bottom display and the other half of the analog outputs can be assigned to the same or
another module. Multiple dashCAN* displays can be attached to the CAN bus.

dashCAN* has two modes of operation: RUN (when measurements are displayed) and SYS
(where dashCAN™ is set-up). The SYS key toggles between the modes.

While in RUN mode:

i. If the T button is pressed, the displays will show the serial numbers of the modules
assigned to the displays.

ii. If the { button is pressed, the displays will show the parameter names assigned to the
displays. See Table 2.

iii. If the ENT button is pressed, the displays will show the units of the parameters.
“PCTG” is %. “dIM” means dimensionless.

In RUN mode, four things other than data can be displayed:

1. “ERR” and “###” where “####” 1s an error code. See Table 3.

ii. “....” which means that a module has not been assigned to that display.

1. “---- which means that dashCAN* has an internal problem.

v. “XXXX” which means that dashCAN* is not receiving any data from the module

assigned to that display.

dashCAN
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When first entering SYS mode, either “MOd” will be on the top display or “LOCK” will be
on the bottom display. If “MOd” is displayed, the T and ¥ keys will roll through the setup
options (see Table 4). First the options for the module assigned to the top display are shown
on the top display, followed by identical options for the module assigned to the bottom
display, ending with the global CONF (Configuration) setup. Pressing the ENT key will
select the displayed setup option and allow its programming.

If “LOCK” is displayed, the dashCAN* has been locked and its setup cannot be changed until
it is unlocked. Appendix F describes how to LOCK and unlock dashCAN*.

Setup Option Level 1 Function
MOd Select module s/n to be assigned to the display. Default is NONE.
RATE Set parameter averaging rate. Range 0.001 to 1.000
Default is 1.000. 1.000 means no averaging.
AOUT (dashCAN+ only)

Al Program analog output 1 from module assigned to top display
A2 Program analog output 2 from module assigned to top display
A3 Program analog output 3 from module assigned to top display
A4 Program analog output 4 from module assigned to bottom display
A5 Program analog output 5 from module assigned to bottom display
A6 Program analog output 6 from module assigned to bottom display

AOUT (dashCANZ2 only)
Al Program analog output 1 from module assigned to top display
A2 Program analog output 2 from module assigned to bottom display

dISP Select parameter. Note: Parameters available are those
contained in TPDOs programmed to be transmitted from
the module (programmed using the Configuration Tool).

CONF LEdS dashCAN+ only. Set display intensity. Default is 3333.
dashCAN and dashCANZ2 have a knob for display intensity.

1V4V dashCAN2 and dashCAN+ only. Command 1V and 4V outputs.

LOCK Lock and Unlock Display for Programming

MOd, RATE, AOUT, and dISP appear on the top display for the module assigned to the top
display and then on the bottom display for the module assigned to the bottom display. CONF
just appears on the bottom display and is for global dashCAN* setup. All entries must be
followed by pressing the ENT key.

Table 4: Menu Tree for dashCAN~*
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MOd (Module) Setup Option

In MOd setup, the serial number of the module assigned to the top or bottom display is
entered. The serial number is written on a label on the module. The module assigned to the
top display will be assigned the first half of the analog outputs. The module assigned to the
bottom display will be assigned to the second half of the analog outputs. The same module
can be assigned to both displays or different modules can be assigned to each display.

After entering MOd (i.e. press ENT when “MOd” is displayed), the serial numbers of the
available modules will be displayed. Select using T and  followed by the ENT key.

RATE Setup Option

Data is transmitted from modules at the broadcast rate and the programmed averaging that
was programmed using the Configuration Tool. This transmitted data can then be further
averaged before being displayed on the displays. Separate averaging can be programmed for
the top display and the bottom display. RATE does not affect the analog outputs.

The averaging is programmed with values from 0.001 (heavy averaging) to 1.000 (no
averaging). The default is 1.000. The averaging is performed as follows:

DisplayedValue; = o x Parameter; + (1 — a) x DisplayedValue;
where:

DisplayedValue; = the new displayed averaged value

a = The user-programmable averaging.
Range: 0.001 (heavy averaging) to 1.000 (no averaging).

Parameter; = the latest value transmitted by the module

DisplayedValue.; = the previous displayed averaged value

AOUT (Analog Outputs) Setup Option (dashCAN+ and dashCAN2 Only)

The dashCAN2 display head has two 0 to 5V programmable analog outputs. The dashCAN+
display head has six 0 to 5V programmable analog outputs. The analog outputs are updated
at the module Broadcast Rate (see Table 1). This can be as fast as every 5 ms. Keep in mind
that the data may be averaged (see Set Averaging Filters in Table 1) before being broadcast
by the module.

Parameter information from the module assigned to the top display (see MQOd) can be sent to
analog output 1 (for dashCANZ2) or 1, 2, and 3 (for dashCAN+). Parameter information from
the module assigned to the bottom display can be sent to analog output 2 (for dashCAN2) or
4, 5, and 6 (for dashCAN+). Only parameters selected as active TPDOs for that module
(using the Configuration Tool) can be output.
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Here is an example of setting analog output 2 for a dashCAN+ (i.e. A2):

Press the SYS key so that “MOd” appears on the top display.
Press the | key until “AOUT” is on the top display. Then press the ENT key.
Press the 4 key until “A2” (analog output 2) is on the display. Then press the ENT

key.

Press the T and 4 key until the parameter (see Table 2) that will drive A2 is displayed.

Then press the ENT key.

When 0V is displayed, press ENT. Using the T, ¥, and ENT keys, set the parameter

value that you want to result in an analog output voltage of OV on analog output 2.

The first time you do this, it may be a little tricky. You are setting one digit at a time

and for some numbers, the display will shift to the left so you can set the right-most

digits. If you get into trouble when programming, press the SYS key twice to exit and

re-enter setup to try again.

6. When 5V is displayed, press ENT. Using the T, |, and ENT keys, set the parameter
value that you want to result in an analog output voltage of 5V on analog output 2.

7. When “AOUT” is displayed, press SYS to return to RUN mode.

o ~ whe

If in the above example analog output 4 was being programmed, AOUT, A4, 0V, 5V, and
your entries would be shown on the bottom display.

dISP (Display) Setup Option

The dashCAN~* display head has two displays, the top display and the bottom display.

In dISP setup, a parameter from the module assigned to the display (see MOd) can be shown
on the display. Only parameters selected as active TBDOs for that module (using the
Configuration Tool) can be displayed.

Here is an example of setting the parameter to be displayed on the top display:

1. Press the SYS key so that “MOd” is displayed.

2. Press the  key until “dISP” is on the top display. Then press the ENT key.

3. Press the T and | key until desired parameter name is displayed. See Table 2. Then
press the ENT key.

4. Press SYS to return to RUN mode.

CONF (Configure) Setup Option

CONF setup appears at the end of the setup list on the bottom display. To enter CONF, press
the SYS key so that “MOd” appears on the top display, press the { key until “CONF” appears
on the bottom display, and then press the ENT key. CONF is for global dashCAN* setup.

¢ LEdS (dashCAN+ only)

The display intensity is programmable. Press the ENT key when “LEdS” appears on the
bottom display, press the T or { keys until the display intensity is suitable, press ENT, and
press SYS to return to RUN mode.

14



¢ 1V4V (dashCAN2 and dashCAN+ only)

“1V4V” commands the analog outputs to go to 1V then 4V. This is used to verify that the
data acquisition system reading the analog outputs is correctly reading them.

¢ LOCK

“LOCK” locks the MOd, RATE, AOUT, dISP, and LEdS setup. This stops unauthorized
modification of the display. Refer to Appendix F for more information.

15



Appendix A: NH;CAN Kit Contents
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The NH;CAN Kit consists of:

Description P/N Quantity
1. NH3CAN Control Module 02-12 1
2. NHjs; Sensor 06-07 1
3. NH3; Sensor Extension Cable 10-02 (1m) 1
4. Flexi-Eurofast Cable 09-04 (0.3m) 1
5. Eurofast “T” 09-05 1
6. Eurofast Terminating Resistor 09-06 1
7. 2m Eurofast 12mm Cable 09-02 1
8. DC Power Cable, DBIF, Banana 11-02 1
9. NH3; Sensor Boss & Plug (18mm x 1.5mm) 12-02 1
10. Manuals and Configuration software CD 13-01 1

Optional Pressure Compensation (add /P to Kit part number):

1. Pressure Sensor, 0-75 psia, 517 kPa 07-05 (USA) or 1
07-07 (metric)

2. Pressure Sensor Tubing 12-08A (USA) or 1
12-11A (metric)

3. Pressure Extension Cable 10-04 (1m) 1

4. Module Y Cable 10-21 1

Optional Cables:

1. NH; Sensor Extension Cable 10-03 (2m) 1
2. Pressure Cable 10-05 (2m) 1
3. DC Power Cable, DBIF, Spades 11-01 1

Optional Power Supplies, Heater, and CAN-to-USB Adapter:

1. AC/DC Power Supply, Universal 24VDC @ 4.2A 04-01 1
(requires P/N 11-17 Deutsch DTM3M to DB9F Cable)
2. Vboost Supply, 10-14VDC to 24VDC @ 14.5A 04-02 1

3. Kvaser Leaf Light CAN Adapter 13-02 1



Appendix B: Module Stand-alone Mode and EIB Mode

CAN data from CAN modules (ex. NH3CAN, NOxCAN, LambdaCAN) can either be taken
directly from the modules themselves or from the CAN port of display heads connected to the
modules. When data is taken directly from one or more modules, each module must in
Stand-alone mode. When data is taken from one or more display heads of a NOx 5210,
Lambda 5220, EGR 5230, or NH3 5250 analyzer, each module must be in EIB mode.

Therefore, the module must be properly configured in Stand-alone mode or EIB mode
depending on how it will be used. When CAN modules are sold alone, they are delivered in
Stand-alone mode. When CAN modules are sold as part of a NOx 5210, Lambda 5220,
EGR 5230, or NH3 5250 analyzer, they are delivered in EIB mode.

To convert from one mode to the other requires software reprogramming of the module
(using the Configuration Tool) followed by the installation (to set to Stand-alone) or removal
(to set to EIB) of a jumper inside the module.

& To convert a module from EIB to Stand-alone Mode

1. Take the nut off the end of the module. Use an 18mm socket without the wrench.
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3. Slide the PCB out. Install a jumper on JP4.

JP4

¢
#
. s
u

5. Slide the PCB into the enclosure until the two tangs “click”.

6. Put the nut on and tighten ONLY % turn from where it is seated. If this nut is
tightened too much, the connector will crack and the enclosure will not be sealed.

7. Connect the module to a power supply and a PC (via a CAN communication adapter)
using the cabling shown. A sensor does not have to be connected to the module.
Note that only one module is connected and a display head is not involved.

19



P/N 11-02, DC Power Cable, To power
Module Serial DB9F, Banana Plugs (shown), or
Number P/N 11-01, DC Power Cable,

DB9F, Spades

Nvoepquel DT

et
eInpoj

k‘T’, JS‘“
“ To CAN adapter

Resistor
On PC

Figure Al: Module prepared for Reprogramming

9. Start the Configuration Tool (software). Click on the “Module” tab.
Select the CAN adapter being used. Then start the communication.

ez FCM Configuration Tool v3.0 Q\i@

ECM Configuration Tool

s i| Display Heads ]

CAN Adapter: IVectOICAN L' ICANcardX Channel 1 L’ START I Status: ]Port Closed .

Configuration ~Toals

NID Prod.# Rev.# Serall LogData...
Module: I 3 Generate .dbc...
Task: I Lj

Calculate %202 in Air

Manual Communication ]

Set Module Mode
ElB Stand-4lone |

Note: This function can only be
used with one module on the bus.

» DS':t'lo' S/N TPDO1 | TPDD2 | TPDO3 [ TPDO4 [
Eror  Aux. I LI I LI - -
r [0 [0 b b
CaNopen State I LJ I ._'_] | :I' I :"
l o o b b

www.ecm-co.com - 408-734-3433 - Los Altos, CA, USA - (c) 2006




10. Click on the “Set to Stand-Alone Mode”. Wait for “Done” Message.

Stop communication and exit program. The module is in Stand-alone mode.

& To convert a module from Stand-alone Mode to EIB Mode

1. Use the Configuration Tool to “Set to EIB Mode”.
2. Remove the jumper on JP4 in the lambda module.

21



Appendix C: Interpreting Data from NH;CAN Modules

« Wet versus Dry Measurements

Percentages of components in the exhaust of an engine are expressed as percentages
(molecule count or volume) or ppm (parts per million. 10,000 ppm = 1%). The numerator
used to calculate these percentages and ppm contains the molecule-of-interest count and the
denominator contains the total number of molecules in the sample containing the “count”.
One of the molecules produced by the process of combustion, and in significant quantities, is
H,0. The percentage of H,O depends on the fuel composition and Lambda but typically
ranges from 2 to 12%

Percentages and ppm calculated by NH3;CAN consider the water molecules in the
denominator and are called “wet” percentages (or ppm). This makes sense since the sensors
are directly in the exhaust where the H,O is present. In contrast to this, classical gas-bench
analyzers almost always remove the water before the gas sample reaches the analyzers. This
IS because the analyzers cannot tolerate condensed water. Therefore, gas-bench analyzers
will report percentages and ppms as “dry” percentages and ppms (i.e. without H,O molecules
counted in the denominator). Some gas benches are able to report both “dry” and “wet”
numbers.

Therefore, when comparing “wet” (or “true”’) NH3 data from NH3CAN to “dry” data from
gas-bench analyzers, realize that the dry percentages and ppm will be 2% to 12% higher than
the wet (or true) readings. To convert from wet to dry percentages use the formula:

Dry percentage (or ppm) = Wet percentage (or ppm) / ( 1 - %H,0/100))

This formula assumes a 100% removal of water before the dry measurement.
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Appendix D: Setting Up ETAS INCA for ECM Modules

Hardware Setup: Using ETAS ES591.1

1. Connect the power port to a power source between 6V and 32V.

2. Connect the Ethernet port directly to the Ethernet port on your PC. This port does not
use an internet/intranet connection like a router.

3. Connect either the CAN1 or CAN2 port to a CAN network (i.e. ECM modules or
display heads).

Software Setup: Using ETAS INCA V5.4.1, Hotfix 22, GM Install
1. Double click the INCA V5.4 icon to open the software.

2. Create a new Database. In the Database menu, select New. Give your database a
name (i.e. a folder name). In INCA, a Database means the current working directory.
Each project is created in a unique directory. When INCA is opened, it will default to
the last Database that was used.

3. Add a new Workspace. Right click on the “DEFAULT” folder icon, select Add >
Workspace. You can rename it to whatever you want.

37 INCA V5.4.1/22
Database Edit Yiew Options Utilities 7

= =] Xl - 0 HRERE D Y

1 Items

m Add 3 Add top Folder
Add Folder Insert
Delete Delete Experiment Chrl+T
c Chrlc ECU-Project (aZ()... Crl+P
apy ! COM-Configuration Alt+C
Measure-Catalog. ..
Rename Fz ECU Documentation, ..
Can-DE...
I List of CAN Messages
Import Ctrl+ Read CAMN Message Log File. ..
Expork Chrl+E
Write: 3
Convert Experiment 3

4. Add a new dbc file for your project. Right click on the workspace you created in
step 3, select Add > Can-DB. Browse to your dbc file and click open. In this
example, we are using a file named test8mod.dbc. An INCA log window will pop up.
You can ignore this.

23




3 INCA V5.4.1/22

Database Edit  Wiew Options Utilities Experiment Project Device 7

D= E & By X (B8 R ESRNEIN 5 m__
IHCA
Lo " INCA V5.4.1/22*
[l {ZdDEFALLT Database Edit Yiew Options  Utilities
T S 1o o = 3 g
A £ . 2
Add Folder Insett D L= E ':"% x "& |
Workspace Chriw 1 Items
Delete Delete Experiment Chrl+T —
E”t E:r::z ECU-Project (A2D. . Crlep =l {ADEFAULT
=Py ! CDM-Configuration Al+C — od
- L4
Measure Catalog.... T Workspace
Rename Fz ECU Documentation, .,
Edit Return
| List of CAN Messages
Lmport Cerk Read CAN Message Log File. ..
Export Chrl+E
Wrike 3
Convert Experiment »

5. Configure the hardware. Click on the icon for the workspace you created in step 3.
Open the Hardware Configuration icon under the section text “6. Hardware”. A
hardware configuration window will open.

IHCA

w INCA V5.4.1/22*

Database Edit  MWiew Options Utilities Experiment Project Device 7

OE $#BEX i@~ &8 SR80 8 vl
1 Ikems 4 Expetiment

=1 ‘I DEFALLT Al 88X

I: B ct5mod |

S Project/device

=19

u

=

[ Hardware/

Workspace L

3 Item comment Caonfigure hardware

(4/1/2006 3:27:24 PM 528 55

|

Filter: none | DB: <test: User: <MainUser >




6. Select the hardware. In the hardware configuration window, right click the “HWK
Workspace” listed under the section text “1. Hardware Devices”, and select Insert.
Select the ETAS device you wish to use. In this example, we are using an ETAS
ES591.1. Expand the selection tree by clicking the “+” next to the hardware device
model. Expand the CAN selection and select CAN-Monitoring. Click OK.

. Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Yiew 7
Mo@-|.. 1 By
IE Add hardware device

Select the new modules you want to add to
the hardware configuration. —
Avvailable HY devices Cancel |

5 R ES600/ESSI0/ESSS1 Multiglcity

—E= T can {Inactive)
CAN-Monitaring; Il— :-I

= amLan —

2 can-output

fucp

cce W

= kwipz000

E=Fups

—E Ek-Line...

EheTrC

LR o T T

1 Hardware devices
Hwi Workspace

|2

<

7. Associate the dbc. When you clicked OK in the last step, another window will pop
up that will allow you to select a dbc that you have added to your workspace from
step 4. Expand the selection tree, select your dbc file, and click OK.

—./Hardware: >Workspace< Experiment: >Default<

File Hardware Device Channels Yiew 7

MO E A8 O e

Select project and working data for CAN-Monitoring:1

1 Hardware devices

HWE Workspace i
I?_ 555991555904’5%591’1 1 Items add ||| 41nfo —
SN: Mok assignes — = — QK
L% CAN:L =] {ZDEFALLT ~ ;l -
@CAN—Monitoring:l L =, bestEmod -
Cancel | sty e

€

Fnent F

|Can_DB... - kestamod

3 Ikem comment
(4/1/2005 3:36:10 PM 937 63)
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8.

Initialize hardware. The hardware is currently stopped, as indicated by the red stop
sign icon next to the selected hardware. You must initialize it before you can use it to
collect data. Click on the Initialize Hardware button on the upper tool bar and wait
for the hardware to complete its initialization. Another window will pop up to
confirm the device to connect to. Click OK.

—'IHardware: >Workspace= Experiment: =D

i’ Connect devices...

File Hardware Device Channels Wiew ?
#o = J4dE B
1 Hard .

MOTRSpECE

ES690/ESS90/ESS21:1
SM: Mot assigned

I— CAM:

Cr-Manitaring: 1

Systems

INCA Hardware Configuration Detected Hardware e} Connected ]

1 Type:
ESE90/ESSI0JESSIL:L
Connect Shiz Not assigned 120411
Disconned 3
Disconnect all
Fiter
Info | o Cancel

HostInterfaceType System type

(@ all connected

9.

—'Hardware: >Workspace= Experiment: >Default<

Open an Experiment Environment. Click on the Experiment Environment button
on the upper tool bar to open an Experiment Environment. The Experiment
Environment is where you can setup the monitoring of the CAN bus. By default, the
Experiment Environment will be blank. You must select the variables from the dbc
file that you wish to monitor. Click on the Select Variables icon in the left hand tool

bar of the Experiment Environment.

Expetiment View Yariables Mea:

File Hardware Device Channels Wew ¥

#o = 1JME B

1 Hardware devices ,{fxperiment environmenk CtrI+F5|
HWE Workspace

iE! ESB90/ESSI0/ESSIL:1

Hor U R OW D

v,
L CAM:L Select variables.. . Shift+F4

€ Can-Manitoring: 1

-
a



10. Select and Configure Variables. Select the variables that you wish to monitor in the
Experiment Environment. These variables names are based on the data found in the
dbc file. Click Configure.

“a; Select variables <Measure variables >

Filtet ‘“ariables Selected 7

1 Devices E 3 Yariables 4 Selected alveady used
= |D:E O Cam-Monitoring: 1 A *0 AFR_0x01  {TPDOZ_Ox01-FF AFR_0x01
—— B2 0 Emergency_0x01 &0 Canopen_Frror_Code_0x01  {Emergency_0x01-F- CANopen_Error_Code_0x01
—— B2 O Emergency_0x02 *C0 CANopen_Error_Reg_0x01  {Emergency_0x01-fr CANopen_Error_Reg_0x01
— B0 Emergency_0x03 *T0 CANopenState_0x01 {Heartbeat_0x01-f} CANopenState_Dx01
—— B2 0 Emergency_0x10 €0 ECM_awsliary_0x01  {Emergency_0x01-F- ECM_Auxiliary_0x01
—— £20 Emergency_nxzo *£'0 ECM_Error_Code_0x01 {Emergency_0xO1-f} ECM_Errar_Code_0x01
— B2 O Emergency_0x21 *0 FAR_0x01  {TPDOZ_Owx01-FF FAR_0x01
—— P20 Emergency_0x22 TEO LAM_ml  {TPDO1_Ox01-f} LAM_0x01
—— £20 Emergency_nxz3 Y0 0z_ox01 {TRDOL_0x0i-f} 02_0x01
— Eg O Heartbeat_0x01
— Eg O  Heartbeat_0x02
— Eg O Heartbeat_0x03
— Eg O Heartbeat_0x10
— Eg O  Heartbeat_0x20
— B2 O Heartbeat 0xz1 ™

Mo raster pre-selection possible!

Configure | Use defaults | Cancel

11. Another window will pop up to configure each selected variable. You can configure,
for each variable, whether to record or simply display the data, how the data will be
displayed (graphs, charts, gauges, numeric, etc.). When complete, click OK. We
have left all configurations at default for this example.

i Configure Selected Yariables |zl@@

Components  Filker  Parameters

2 Parameters

Parameter I
Mame Stabe dT =7 ‘window Display type Device
AFR_0x01 Dispfrac Layer_1>»<Meas.> Murn ZAM-Monitoring: 1
CAMopen_Error_Code Dispfrec Layer_1=x<Meas. = Murn ZAM-Monitoring: 1
CAMopen_Error_Req. Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
CAMopenState_0x01 Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
ECM_Auxiliary_0x01  Dispfrec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
ECM_Errar_tCode_0x( Disp/rec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
FAR_Ox01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
LaM_0x01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
0Z_0x01 Disp/rec .Layer_1=><Meas.> ’—L| CAN-Monitoring: 1

Active Component: <Experiment:=  |Active Filter: <all Types= |Active Parameter: <OZ_0x01=

QK Cancel

12. A new sub-window will be added to the Experiment Environment. You do not need
to select all the variables you want to monitor all at once. You can click on the Select
Variables icon again at a later time to add more variables. Each set of variables you
add will be placed in a new sub-window unless it is configured to join an existing
sub-window. In this example, we have created a sub-window for each of the eight
modules in the dbc file.
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Experiment: >NewExp= Hardware: >Workspace<

Experiment Yiew Varjables Measurement Hardware Dataset Components tindow 2

D | re—" B[] 2] Measure window [+ 8| |8 Measure windo =
z 02_0x01 [ - 126 Q2R _0x10 I - [ 126] O2_0x22 ] - 13%]
— | AFR_Dn01 I -In CAMopen_Error_Reg_0x10 | [thex) | AFR_Dx22 ] -lo
g CAMopen_Error_Code_0x01 H -H[hex] CANDpen_Errcr_Code_DxWD[l -ﬂ[hex] CANDpen_Errcr_Code_Dx22|l —H[hex]
; CANopen_Error_Reg_0x01 H = H [hex] CAMNopenState_0x10 [l -|| [hex] CAMopen_Error_Reg_0x22 || —H [hex]
. | SANorenstate o1 | -lihed | ECM_Awdliary_0x10 [ -|ihed | CANopenState_0xz2 I - thex
| Eoh Adliany Dl | “|ihed | ECM Error_Code_0x10 [ Jihed | ECM_Ausdliary_0x22 I - thex
3: ECM_Error_Code_ 0w | Jiheq fiP1_oxi0 [ |ima] | ECM Error_Cods_0x22 I - thex
mm | FAR_0:01 | o P2 010 [ [ wal FAR_ =22 I o
o llLani o [ o WO _0x10 I Jippm) [fLar mx22 I B [
y L do | %] Measure windo =] =] Measure window [3 =)
e | O2_0x02 I - 12%] 0z_0x20 I - 12] AFR_0x23 I -|n
Il | AFR D2 | -To AFR_ 0520 [ -To CARNopen_Error_Code_0x23 | -|thex
2] CAMNopen_Error_Code_0x02 H fﬂ[hex] CAMopen_Error_Code_0x20 [l fﬂ[hex] CAMopen_Error_Reg_0x23 |] ﬂ[hex]
g CAMNopen_Error_Reg_0x02 H = H [hex] CAMopen_Error_Reg_0x20 [l = H [hex] CAMNopenState_[x23 |] || [hex]
g | SAnepenSiate 0x02 | “Jihexd | CANopenState_0x20 [ Jihex) | ECM Ausiliary_0x23 [ | thex
7 | ECM_Awidliary_0x02 | Jiheq | ECM Ausiliary_0x20 [ ~|lhex) | ECM Error_Code 0x23 [ | ihe
ECM_Error_Code_0x12 [ -|ihexg | ECM_Errer_Ceds_0x20 [ e | FAR_0x23 [ o
FAR_0x02 I -Io FAR_0x20 I -Io LAM_0x23 I -Io
LAK_ 02 I -1n [N[Car oo I -1n 02_0x23 I BES
= asure do O | Measure dow [6 m|
Q2R_0x03 | - [z] 02_0x21 - [24]

CAMNopen_Error_Code_0x03 |I
CAMNopen_Error_Reg_0x03 ||
CANopenState_0=03 ||
ECM_Avsdliary_0x03 [
ECM_Error_Gode_0x03 [
I
I
I

- | [hex] AFR_Ox21
- | [hex] CAMopen_Error_Code_0x21
- | [hex] CAMopen_Error_Reg_0x21

[ l [
[ l [
[ l [
[ I [
= H [hesd CaAMlopenState_x21 || —H [hex]
[ l [
[ l [
[ | [
[ | [

-| [hex] ECM_Awuxiliary 0x21

- | [mA] ECM Error_Code_0x21
1P2_0x03 sl FEaR o

MO 0x03 - [pprr] LA 0x21

) |Measurement stopped Maz. buffer level: 0%

1P1_0x03

13. Start CAN monitoring. Right now there is no data displayed. That is because the
CAN monitoring is stopped. To begin CAN monitoring, click on the Start
Visualization icon (blue triangle) on the left hand tool bar. To stop CAN monitoring,
click the Stop Measuring icon (black square) on the left hand tool bar. To begin
recording the data, click on the Start Recording icon (red circle) on the left hand tool
bar.

e | 02 Ox02

I | AFR_0x0Z




Appendix E: Setting Up ATI Vision for ECM Modules

NOTE: While shown here for a single LambdaCAN module, the same procedure applies for any of
ECM’s CAN-based devices (ex. NH3CAN) as well as for multiple modules simultaneously connected
on the same bus.

Introduction

Connecting ECM LambdaCAN hardware to ATl VISION software is simple and does not require any
third-party software interface. Using the ECM Configuration Tool software to produce a .dbc database
file, and the ATI VISION CANMonitor interface, any available hardware CAN interface can be used to
read LambdaCAN data.

Hardware Setup

A typical hardware configuration is shown in Figure 1. In this example, a Kvaser Leaf Light CAN-USB
adapter is used. Other supported adapters have a similar procedure. Connect the DB9 CAN connector
of the LambdaCAN to the PC to CAN adapter. Supply 11-28V DC (5A min. supply) to the
LambdaCAN.

PC with PCto CAN DB9 Connector
ATI VISION Adapter

and ECM UsB ( .
Configuration L Kvaser Leaf Light

Tool L
Termination
/ Resistor
—1
DC Power Supply
11-28V
|
[ ]
Software

e ATIVISION 3.6.2
e ECM Configuration Tool v4.13

Figure 1: Equipment Schematic Layout
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Creating a .dbc File

The ECM Configuration Tool is used to create a .dbc database file for describing the CAN
messages broadcast from the LambdaCAN. All ECM products with a CAN interface use the

CANopen protocol at 500kHz by default. To generate a .dbc file using ECM Configuration
Tool:

1. Connect hardware as shown in Figure 1. Ensure LambdaCAN bi-color LED indicator
near sensor connector is visible (green during normal operation, flashing red without
sensor attached).

2. Run ECM Configuration Tool software, and select the Modules tab (or the Analyzers

tab if connecting to 5200 series analyzers).

Select CAN adapter from drop down menus as shown in Figure 2, and click START.

4. After LambdaCAN module(s) have initialized, select desired parameters to transmit
from the TPDO drop down menus for each module.

5. Click Generate .dbc, and save this file in a location such as the VISION Projects
folder.

6. Click STOP to end CAN connection.

w

NOTE: Whenever TPDO’s are modified, a new .dbc file must be created.

ECM Configuration Tool || ECM Configuration Tool

Modules ] Analyzers] Firmweare Upgrade] Toggle YW arings [Mow: OFf] Modules ]Analyzels] Firmware Upgrade ] Toggle ‘Wamings [Mow: OFf]

CAN Adapter: [Kvaser ~|[CealLight H3 0[ChD) -] [600Kbpsfoidl_— | [STARTS] Status [l CAM Adapter. [Kaser |[Ceaf light M5 0ichn) < |[500<bpsistd =] STOP | Status: [l

Configuration Toals Configuration Toals
NI Prodf Rev.#  Senial# ECM Bus Load Log Qfata [0 | NI Prod# FRev#  Serial# ECM = ‘

Log D ata [OFf]
Module: | || | 0% ofps YT | [ Module: [0410 0x02  O40E  0:034D v| | [18% 606 fps ] Lser bl

Task: | / =) TotolBus Load ManuaIComr’ Set CAN Baud Task | Change Node ID 21| rota Bus Load Manual Comm. | Set CAN Baud

[0%2. 0 ps Colo, %02 inp, w [19%. 824 fps Calo. %02 n Ai

Set

Set Module Mode Flange: 001 - Os7F Set Module Mods

EIB | Stand-tlone ‘ ECM recommends labeling the madule with the new MID. EIB | Stand-dlone

Mate: This function can only be The following CAN 1D are used for each module: Nate: This function can only be
uged with one module on the bus = used with one rmodule o the bus
Drata for Nade [D: MAA Data for Nade |D: 010 TPDO: Data transmitted by module
Sensor 5/N TPDOT [ TPDOZ [ TPDOZ [ TFDO4 [ Sensor 57N TPDO1 v TPDOZ v TPDOZ v TFDO4 v
S S S I S (N B e s B e N e N s

Emar  Aux Emor  Aux

0 0 0 0 EFEERE 325409 M7 ks 85 b

| | | | Bolbm] [ [ [ 2| ohms
ErorP CO State | =l | =l | =l | =l osael2 -l [Fer -] [Ptz =] [vHCM  ~]

[o [o [o [o na 0«05 [20954 % |0.307305 [e.om1s  mA 8 Y

www.ecm-co.com * 408-734-3433 « Los Altos, CA, USA = {c¢) 2011 wWWww.ecm-co.com « 408-734-3433 « Los Altos, CA, USA = (¢} 2011

Figure 2: ECM Configuration Tool
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Setup CANMonitor using ATI VISION

ATI VISION CANMonitor provides a method of reading general purpose information from any
available CAN channel. The .dbc file generated by the ECM Configuration Tool is used to describe the
format of the information available to VVISION. To setup a CANMonitor in ATI VISION:

1. Run ATI VISION and open an existing Project File or create a new one by clicking File -
New -> Project File. In this example the Project has been named CANMonitorProject.

New... Ctrl+MN

Open... Ctrl+ O

54 Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

[ project File
®HEstrategy File

.EEMX configuration File
ﬁ Calibration File

[ kaM Data File
[Elscreen File

£ ASCIT Text File
@RTF Document File

Description
IVV'ISION project settings and device configuration

2. Add a Device by clicking Device - Add Device, select PC Based CAN Channels from the

list.

HIEI File Edit View Project

Device Tools Window Help

E e SR )

IR

F=| Add Device... F5

=] Remove

=3 Properties Fo

Context Menu

FR5-232 Serial Part

& UsB Port

B8 TCR/IP Port

7 PCMCIA Port

BB Pl Port

SPvirtual CAN Channels
S2PC Based CAN Channels
QSpeciﬁmﬁnns

Description
IVPC Based CAN Channels on this computer.

31



32

3. Add a physical hardware device by clicking Device = Add Device, and select Kvaser CAN

Channel.

H@ File Edit View Project

Device Tools Window Help

[0z e @@= o SEETENNEN

=4 Remove Device

&5 Properties F&

Context Menu

i H D
Select Device Type -

P Kvaser CAN Channel
' Vector CAN Channel
SPEtas CAN Channel

Description
(K\taser CAN Channel on this computer

4. Select a CANMonitor device by again clicking Device - Add

CANMonitor.

“@l File Edit Wiew Project

Device Tools Window Help

IEErCEEEE e

= Remove Device

Device

\3 Computer
=2 PC Based CAN

== KvaseCharre |

= Properties Fo

Context Menu

Device, and select

52 CAN Monitor

%CCP Controller Device

%XCP Controller Device

B kwP2000 CAN Device (Flash Only)
¢ CSM DAQ Network

2 IMC DAQ Network

% IPETRONIK DAQ Metwork

Description
IVCAN bus message monitor virtual device




5. Add the .dbc file generated from the ECM Configuration Tool to CANMonitor by clicking
Device - Add CAN Database and browsing to the previously created .dbc file.

Hlﬁl File Edit View Project

Device Tools Window Help

ok s

={ Remove Device

[5)|Add CAN Database... =

Computer
= WIS2 PC Based CAN
= W52 KvaserChannel

-

& Properties Fa

CANMonitor

Ltlire:

, | = BEckE-

Look in: | | VISION Projects

MName Date modified

9/28/2011 3:18 PM
9/30/2011 5:27 PM

Type
File folder
DBC File

. Samples
2 LambdaCAMTest.dbc

1

File name: ILambdaCJ\NTest.dbc

Files of type

i : |CAN Database Files (*.dbe:"uef)

6. Enable the hardware by clicking Project = Online. The status of all of the devices should
now show a Status of Online, and a value should appear in the Data Rate column of the

Project wi

ndow.

JIEI File Edit View | Project Device Tools Window Help

-
- 2 \ehicle Manager...

tus

v Computer Proposed Values » line

E‘E PC Based C/ ne

= W52 KvaserT| M Panic Apply Base F12 ne

= WIS2 CANMGHTET Thtline

o Ml | ambdaCANTest Bctive
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7. To view data, create a new Screen File and add a Control. Click File > New - Screen File

Tools Window Help

IR [[ ) = e 6 x o - - |

Open... Ctrl+O

Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

8. Select Object > Add Control - Gauge

“ File Edit View Project | Object Dataltern Tools Window

(5] Project File
®Estrateqy File

®EEMY configuration File
ﬁ Calibration File

[ kaMm Data File
Screen File

L) ASCIT Text File
gRTF Document File

Description
VISION real-time document used for interacting with data

@ Delete Ctrl+Delete

Tile controls

m Cut
Copy
Paste

B Properties F&

DEeR@ =

Ctrl+F10

Context Menu
Track Residency
5] Clear Residency

EData List
BB stripchart Recorder

E=12D Table Grid
[E 30 Table Grid
E5tate Array
(% Gauge

1 Bar Graph

:i, Thermometer
@ LD

aLED Array
5 Seroll Bar
Oypial

i Switch

% Dashboard
CAN Trace

"Descripﬁon

Gauge




9. In the Select Data Items window open the CANMonitor file tree to view all of the available
signals. Here the O2% from Node 0x10 has been selected. Click OK to add the Data Item to
the Control.

' Select " Find

I Advanced. .. | OF I

[C1 DatakemGroups Data Item £ I Type | Canicel |
=27 CANMoritor
=& Node_{x10

“er LAM 010 CAN Signal
CAN Signal Help

Mext |
Previous |

T —

Selected Data ltems I Comments

Add |
Remove |

10. Data should be visible on the gauge.

lam@aa Lty aRE W J

02_0x10 (%)

%  CANMonitorProject

“IDefaultVehicle Zlft @B m|B] =l “‘/ % | B[ o ol ik |+ -

For Help, press F1 |— Default User |Online NUM 10/3/2011 11:46:18 AM_~
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Appendix F: LOCKing and unLOCKing dashCAN*

When dashCAN™ is locked, its setup cannot be modified.
¢ To LOCK dashCAN*

Press SYS until “MOd” is displayed.
Press ¥ until “CONE” is displayed. Then press ENT.
Press ¥ until “LOCK” is displayed. Then press ENT.

“50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN™* is now LOCKed.

L

& TounLOCK dashCAN*

1. Press SYS until “LOCK” is displayed. Then press ENT.
2. “50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN* is now unLOCKed.

If an unauthorized person learns that 60 is the key number, contact ECM.
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E CM ENGINE CONTROL 586 Weddell Drive, Suite 2
Sunnyvale, CA 94089-2134
AND MONITORING USA

Phone: (408) 734-3433
FAX: (408) 734-3432
Email: sales@ecm-co.com
Web: www.ecm-co.com

EC DECLARATION OF CONFORMITY

We declare under our sole responsibility that the products:

AFM1540 Lambda Module

AFM1600L, AFM1600D Modules

DI1S1000 Display head

EGR 4830 Analyzer

NOx 5210 NOx Analyzer

Lambda 5220 Lambda Analyzer

EGR 5230 EGR Analyzer

NOX/NH3; 5240 NOx and NH; Analyzer

NH; 5250 Analyzer

LambdaCAN, LambdaCANc, LambdaCANd, LambdaCANp Lambda Modules
NOx 1000, NOXxCAN, NOxCANg, NOXxCANt NOx Modules
NH;CAN Module

baroCAN Module

dashCAN, dashCANCc, dashCAN+, dashCAN2

appsCAN

SIM200, SIM300, SIM400, SIM500, SIM600, SIM700, SIM800
BTU200

To which this declaration relates are in conformity with the essential requirements of the following standards:
EN61326: 1997/A2: 2001 (Class A & Annex A)
EN61010-1: 2001 (Electrical Safety)

And therefore conform to the requirements of the following directives:

89/336/EEC Electromagnetic Compatibility (EMC)
72/23/EEC Low Voltage Directive (LVD)

Ronald S. Patrick

Vice President Sales
February 20, 2015

37


mailto:sales@ecm-co.com

38






ECM ENGINE CONTROL
AND MONITORING

Los Altos, CA 94023-0040 * USA * (408) 734-3433 ® Fax: (408) 734-3432 * www.ecm-c0.com



